
ClearCase LT Release Notes
Version 2001A.04.00
WINDOWS
These release notes present information about the definition, delivery, and operation

of Rational ClearCase LT configuration management software.

Product Definition

ClearCase LT software for Windows operating systems offers client/server solutions

for configuration management software. ClearCase LT Server software must be

installed on a host in the same network domain as the hosts on which you install

ClearCase LT Client software. A client can access only one ClearCase LT server at a

time. To ensure adequate performance for all ClearCase LT clients, we recommend

that you install ClearCase LT Server on a dedicated host.

Before you install ClearCase LT software, read the Rational Suite Release Notes
(distributed with your software) and Supported Architectures in this document.

What’s New in ClearCase LT

This chapter summarizes significant new and changed features in Rational

ClearCase LT.

New features are documented in the ClearCase Product Family Documentation
Supplement, which is installed as a PDF file in ccase-home-dir\bin\cpf_supplement.pdf.

Summary of Changes in This Release

ClearCase LT Version 2001A.04.00 introduces the following significant new and

changed features:

■ Changes to UCM Integration with ClearQuest

■ Supporting Users Who Are Members of More Than 32 Groups

■ Integration with Sun Forte for Java
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■ Integration with VisualAge for Java

■ Changes to ClearCase Commands

Changes to UCM Integration with ClearQuest

ClearCase LT Version  2001A.04.00 includes support for the new release of

ClearQuest.

For information on planning and setting up the UCM-ClearQuest integration, see

Managing Software Projects with ClearCase. For information about setting up the

integration with ClearQuest and upgrading your ClearQuest schema to the latest

UCM package, see the ClearCase Product Family Documentation Supplement.

New UCM Features

Following are features new in UCM:

■ Obsolete Objects in UCM Listings

■ Privileged Identity for PVOB Write Operations

■ Component Tree Browser Enhancements

Obsolete Objects in UCM Listings

By default, UCM listing commands do not list obsolete objects. A new option,

–obsolete , includes obsolete objects in the listing. See the reference pages for lsactivity,

lsbl, lscomp, lsproject, and lsstream in ClearCase Product Family Documentation
Supplement.

UCM Triggers

Version 2001A.04.00 adds support for triggers on the following UCM operations.

■ deliver

■ mkactivity

■ mkbl

■ mkstream

■ rebase

■ setactivity

Properties information for triggers used with UCM objects is now shown on the Firing
Conditions  tab of the property sheet for a trigger.
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See the ClearCase Product Family Documentation Supplement for reference pages on the

mktrtype, mktrigger, and rmtrigger commands, and a chapter that shows sample

triggers.

Privileged Identity for PVOB Write Operations

Operations that write to the UCM project VOB now require a privileged identity. The

following commands write to the project VOB:

■ chactivity

■ chbl

■ chproject

■ chstream

■ clearjoinproj

■ deliver

■ mkactivity

■ mkbl

■ mkcomp

■ mkproject

■ mkstream

■ rebase

■ rmactivity

■ rmbl

■ rmcomp

■ rmproject

■ rmstream

■ setplevel

See the corresponding reference pages in the ClearCase Product Family Documentation
Supplement for details.

Component Tree Browser Enhancements

To reduce the amount of information that the Component Tree Browser displays for

UCM streams and baselines, which makes the information easier to read, the Filtering
Options  dialog box was added. The filtering also reduces the amount of time

necessary to load the component depicted on the tree. For streams, you can display no
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development streams, your own development stream only, or all development

streams in the component. For baselines, you can display only the baselines of a given

promotion level or higher, only labeled baselines, or obsolete baselines.

Supporting Users Who Are Members of More Than 32 Groups

ClearCase LT Version 2001A.04.00 supports the use of a new environment variable on

Windows NT and Windows 2000 platforms.

If the user environment variable CLEARCASE_GROUPS exists for any user, ClearCase

considers the semicolon-separated list of groups specified in the value of this variable

first when determining (or displaying) which groups a user belongs to. For example:

CLEARCASE_GROUPS=DOMAIN\ClearCase Users;DOMAIN\group1;DOMAIN\group5

The list can contain domain or local groups, and need not contain the group specified

in CLEARCASE_PRIMARY_GROUP, which is already treated specially if it has been

specified. If the user is a member of additional groups not specified in

CLEARCASE_GROUPS, ClearCase considers those groups after it has considered the

groups listed in CLEARCASE_GROUPS, up to a limit of 32 groups.

Any user who is a member of more than 32 groups (domain or local) should set

CLEARCASE_GROUPS to specify which of these groups ClearCase should consider

when checking the user’s access rights. CLEARCASE_GROUPS is not supported on

Windows 98 or Windows Me.

No Support for Windows 95

Beginning in Version  2001A.04.00, ClearCase LT does not run on Windows 95.

Integration with Sun Forte for Java

This release provides the integration of the SCC level of ClearCase functionality with

Sun Microsystem’s Forte for Java Release 2.0 toolkit on

■ Windows NT, Windows 98, and Windows 2000

■ Sun Solaris (Versions 2.6, 7, and 8)

Users of the Java IDE initiate ClearCase actions using the file-system shortcut menus

and a set of command icons on the Forte for Java main window toolbar. The following

functions are available:

■ Check In

■ Check Out

■ Add to Source Control
4 Supporting Users Who Are Members of More Than 32 Groups



■ Undo Checkout

■ Properties

■ Compare to Predecessor

■ Source Control History

■ Version Tree Browser

■ ClearCase Explorer

ClearCase integrated help appears as a book in the Forte for Java online help, which

you can access from the IDE Help  menu. Context-sensitive help, invoked by pressing

F1, is also available for the ClearCase commands.

Integration with VisualAge for Java

This release provides integration of the SCC level of ClearCase functionality with the

IBM VisualAge for Java Release 3.5 on Windows NT, Windows 98, and

Windows 2000.

Users can develop projects in the VisualAge for Java IDE, while performing ClearCase

version management using the file-system shortcut menus and a set of command

icons on the VisualAge for Java main window toolbar.

The integration provides access to the following ClearCase functionality:

■ Unified Change Management (UCM) Deliver and Rebase functions

■ Version Tree Browser

■ Unified Change Management (UCM) Join Project

■ Merge Manager

■ Create View

■ Update View

■ Find Checkouts

■ Online Help about using this integration

Handling of Resource Files in VisualAge for Java

When you add a resource to a project that is in source control, the green arrow or

yellow plus sign does not update after the resource has been added as an element to

ClearCase.
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Known Problem with Lengthy Error Messages

If you attempt to add projects with very long names, including long class names, to

source control, an internal error message appears. The error routine cannot handle

very long error messages that result from adding these types of projects to source

control.

Setting Project Properties When a Project is Added to Version
Control

After a project is added to External Version Control, users must set the project

properties to tell VisualAge for Java (on a refresh project), to refresh the project from

the external version control repository. To do this, select the Project Tools >External
Version Control >Properties  from the shortcut menu for the project. Select the SCCI

tab, and then the Refresh project from working directory option. This property only

needs to be set once for the project.

More Information on VisualAge for Java

For more information on VisualAge for Java, including new updates and limitations,

read the IBM VisualAge for Java release notes.

Changes to ClearCase Commands

This section lists new commands and describes changes to ClearCase commands.

New Command

Table 1 lists a new command for this release.

Table 1 New ClearCase Commands

Command Description

clearfsimport A new utility that allows you to place source files under ClearCase
version control. You can run it in a UCM or base ClearCase view.
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New Options and Arguments

Table 2 lists new options and arguments.

Table 2 New ClearCase Command Options

Command New option/argument Use

diffbl –predecessor
[ –activities ]
[ –versions ]
baseline-selector

Nongraphically displays differences between the
specified baseline and its predecessor baseline.

–graphical
baseline-selector1
baseline-selector2

Displays differences between two baselines
graphically.

–graphical
–predecessor
baseline-selector

Displays differences between the specified baseline
and its predecessor baseline graphically.

clearimport -noload Reduces the time needed to import versions from flat
files or other version control systems into a VOB.

To load new versions, the user must update the
workspace manually.

See the the reference page for full details on the
behavior of the -noload  and related -identical  flag.

lsactivity
lsbl
lscomp
lsfolder
lsproject
lsstream

–obsolete Specifies that obsolete objects are to be included in
the listing.

mktrigger ucm-object-selector Attaches a trigger to the specified UCM object.

mktrtype –ucmobject Creates a UCM trigger type that can be attached to
individual UCM objects.

–ucmobject –all Creates a UCM trigger type that can be attached to
all project VOB objects.

–component
component-selector[,...]

Specifies components for the restriction list.

–project
project-selector[,...]

Specifies projects for the restriction list.

–stream
stream-selector[,...]

Specifies streams for the restriction list.

rmtrigger ucm-object-selector Removes a trigger from the specified UCM object.
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Obsolete Commands

No commands are obsolete in this release.

Supported Architectures

This section lists the basic platform and software requirements for running

ClearCase LT software. There are no special hardware requirements on Windows

systems.

Supported Platforms

ClearCase LT software runs on the platforms listed in Table 3.

Windows/UNIX Interoperation

ClearCase LT clients access files in UNIX VOBs through the ClearCase File Server

(CCFS) using standard TCP/IP based networking. Similarly, ClearCase LT UNIX

clients can access files in Windows VOBs.

NOTE: ClearCase LT does not support dynamic views.

For more information about CCFS, see the Administering ClearCase manual.

Basic Software Requirements

ClearCase LT requires the following software on Windows NT, Windows Me, or

Windows 2000:

■ Windows Workstation or Windows Server

■ TCP/IP (shipped with Windows NT 4.0, Windows Me, and Windows 2000)

Table 3 Supported Platforms for ClearCase LT Software

Hardware platform Operating system

Intel x86 Windows 2000,, SP1

Windows NT 4.0, SP4, SP5, SP6a

Windows Me (ClearCase LT Client only)

Windows 98 all versions (ClearCase LT Client only)1

1. Rational ClearCase 4.2 clients support the latest Windows 2000, Windows Me and Windows 98
releases. Older releases of Windows 9x such as Windows 95 are no longer supported with this
release. Customers who require support for Windows 95 should run an earlier version of
ClearCase (4.1) or upgrade their Windows 95 clients to a newer release of Windows.
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■ Internet Explorer 4.0.1 SP1 or later; note that this does not have to be the default

browser, but is required for use of some ClearCase features, including the

ClearCase Explorer, the HTML Diff Merge tool, the ClearCase Automation Library

(CAL), and the ClearCase Administration Console.

■ If acting as a ClearCase Web server: Web server software, either Apache (1.3.6 or

later), Netscape Enterprise (3.5.1 or later), or Microsoft Internet Information Server

(IIS 4.0 or 5.0).

■ If acting as a server for the ClearCase integration with FrontPage 98, FrontPage

2000, or Visual InterDev: IIS Web server software and the FrontPage Server

Extensions (FPSE).

■ An Adobe Acrobat Reader, release 3 or later, to access the online manuals, which

are in PDF format.

■ On any system accessing ClearCase LT through the Web interface, a Web browser;

either Netscape 4.6 or later, or Internet Explorer 4.0.1 (SP 1) or later. (Note that it is

not necessary to install ClearCase LT on such a system.)

ClearCase LT software requires the following software on Windows 98 systems:

■ Windows 98

■ Client for Microsoft Networks (shipped with Windows 98)

■ TCP/IP (shipped with Windows 98)

■ Windows Sockets 2 (shipped with Windows 98)

■ Internet Explorer 4.0.1 SP1 or later; note that this does not have to be the default

browser, but is required for use of some ClearCase features, including the

ClearCase Explorer, the HTML Diff Merge tool, and the ClearCase Automation

Library (CAL).

■ An Adobe Acrobat Reader, release 3 or later, to access the online manuals, which

are in PDF format.

■ On any system accessing ClearCase LT through the Web interface, a Web browser;

either Netscape 4.6 or later, or Internet Explorer 4.0.1 (SP 1) or later. (Note that it is

not necessary to install ClearCase LT on such a system.)
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Disk Space Requirements for the Release Area

The following table shows the minimum disk space required on each type of

network-wide release host.

Disk Space Requirements for Individual Hosts

Table 4 shows the approximate disk space requirements for a new installation of

ClearCase LT software. These figures are for ClearCase files only; include

approximately 5 MB extra for temporary storage during the actual installation.

If a host will have view directories, the system needs enough disk space to contain all

files loaded into the views and all view-private files added to the views. The amount

of space required depends on the number and sizes of the files in the views.

The ClearCase LT server must have enough disk space to contain the files and

databases used for storage of VOB- or view-storage directories. The amount of space

required depends on the characteristics and use of the VOBs and views.

Web Site of Operating System Vendor

You can find up-to-date information on Microsoft Windows operating system issues

at the Microsoft Web site www.microsoft.com.

File system Disk space

Windows NT

Windows 2000

128 MB

128 MB

Table 4 Disk Space for ClearCase LT Files and Upgraded System Files

ClearCase LT software Disk space required (MB)

ClearCase LT Client 60

ClearCase LT Server 90
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ClearCase Patches Incorporated in This Release

ClearCase LT Version 2001A.04.00 incorporates all ClearCase patches since the release

of ClearCase Release 4.1. Table 5 shows the specific ClearCase patches.

ClearQuest Compatibility with ClearCase LT

ClearCase LT supports the option of integration with Rational ClearQuest. You can

integrate the software in two different ways:

■ If you install ClearCase LT with the Unified Change Management (UCM) option,

integration with the current version ClearQuest is supported.

Therefore, for this release of ClearCase LT, integration requires ClearQuest Version

2001A.04.00. If you have an older version of ClearQuest, you must upgrade to this

version before configuring the integration.

■ If you install ClearCase LT without the UCM option, you can integrate with

ClearQuest Version 1.1 or later using the ClearCase-ClearQuest integration 1.0.

Using ClearCase LT and Windows NT Server Domains

ClearCase LT is a distributed client/server application; many operations initiated on

client hosts are completed by server processes elsewhere in the network. Therefore, all

ClearCase LT hosts running Windows NT must belong to a Windows NT Server

domain, except as noted in Administering ClearCase. On all Windows 98 hosts, the

Client for Microsoft Networks component in Network properties must be configured

to log on to a Windows NT Server Domain.

To use ClearCase LT from a supported Windows host, you must log on to a domain

account (not a local, per-system user account). For more information about

Windows NT Server Domains, see Administering ClearCase.

Table 5 ClearCase Patches Incorporated in This Release

Patch stream Last patch incorporated

ClearCase 4.1 clearcase_p4.1NT-15 and earlier
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Getting Started

This section contains information to familiarize you with installing, setting up, and

using ClearCase LT software.

Pointer to Installation Information

Refer to Installing Rational Suite for installation information. It provides instructions

on installing ClearCase LT Server and ClearCase LT Client software, lists required

products, and contains information about removing Rational software and

troubleshooting.

Licensing

Refer to Administering Licenses for Rational Software for licensing information necessary

for installation and initial operation of ClearCase software.

If you have a floating evaluation license for ClearCase LT or for ClearCase LT and a

Rational Suite Studio product, you must install a FLEXlm server to activate your

evaluation license. You can activate your floating evaluation license from the Rational

License Key Administrator window by clicking License >Enter a License . For more

information on installing a FLEXlm server, refer to Administering Licenses for Rational
Software.

Installation Issues

This section discusses restrictions or defects that involve the installation of the

ClearCase LT product. Take into account the information in this section before or

during installation to be sure that ClearCase software or particular features are

installed properly.

Installing Internet Explorer 4.0.1 SP1

If some features of ClearCase LT software are to perform properly, Internet Explorer

4.0.1 (Service Pack 1) or a later version of Internet Explorer must be installed on your

system.

Note: It is not necessary to run Internet Explorer as a browser on the system; it simply

needs to be installed.

The presence of Internet Explorer is required for the ClearCase Administrative

Console (implemented as a set of snap-ins to the Microsoft Management Console), for

use of the ClearCase Automation Library (CAL), and for use of the enhanced Diff

Merge Tool with HTML files.
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Installing Java VM with Internet Explorer

A Java virtual machine (VM) is required for the ClearCase LT Web interface.

However, recent versions of Microsoft Internet Explorer no longer install the VM by

default. For these versions, you must perform a custom installation of IE, selecting the

Microsoft virtual machine  component.

Setting Up the VisualAge for Java Integration

The ClearCase LT integration with Visual Age for Java enables you to use

ClearCase LT source control functions, such as checking out, modifying, and checking

in your files, without leaving the Visual Age for Java IDE or starting another

application.

Before you can configure the VisualAge for Java for ClearCase LT integration, you

must install both VisualAge for Java and ClearCase LT, in any order, and then run the

VisualAge for Java Integration Configuration Wizard. This section describes all three

procedures.

Installing VisualAge for Java

1 Run the installation program for IBM VisualAge for Java Version 3.5, Enterprise

Edition. Follow the installation instructions and prompts.

2 During the installation, select the Custom  option. In the list of components to

install, select the External Version Control  option.

Note: If you already installed VisualAge for Java, make sure the IDE is closed.

Then run the installation program again. Choose the Modify option, specify a

custom install, and select the External Version Control  option

3 Download and install the latest patch from www.ibm.com for the VisualAge for Java

Version 3.5, Enterprise Edition.

Installing ClearCase LT

If ClearCase LT is already installed and running on your system, skip this procedure.

If ClearCase LT is not installed, run the ClearCase LT installation program as you

normally would, with the addition of the following steps.

1 Step through the installation to the Standard or Custom Client Configuration

window. Click I will create my own custom client configuration , and click Next  and

continue with the installation.

2 In the Site Defaults window, click No, I will customize this ClearCase LT installation .

Click Next  and continue with the installation.
ClearCase LT Release Notes 13



3 In the Start Menu Entries  window, locate the list of ClearCase LT Administration

Start Menu entries. Click VisualAge for Java Integration Configuration . Click Next
and finish the ClearCase LT installation.

Running the Configuration Wizard

After both VisualAge for Java and ClearCase LT are installed, you must run the

VisualAge for Java Integration Configuration Wizard. Select one of the methods listed

here:

If you installed ClearCase LT using the procedure titled Installing ClearCase LT in this

section:

In your Windows taskbar, click Start >Programs >Rational ClearCase
Administration >Integrations >VisualAge for Java Integration Configuration.

If ClearCase LT was previously installed or if the VisualAge for Java Integration
Configuration shortcut menu does not appear in the Integrations menu:

1 In your Windows Taskbar, click Start >Run.

2 In the Run window, enter the path to the file, vaj_config.exe, in the bin folder of

your ClearCase LT installation. For example, a typical path is

C:\Program Files\Rational\Clearcase\bin\vaj_config.exe.

3 Click OK.

Set CLEARCASE_PRIMARY_GROUP on Windows Systems

ClearCase access controls consider domain group membership information when

determining a user’s rights to access ClearCase data. Because of a bug in

Windows NT, a user who logs on to a domain account may not be assigned the

primary group specified by the Windows NT domain account management tools.

To work around this bug, we recommend that you set the user environment variable

CLEARCASE_PRIMARY_GROUP to refer to the correct primary group. The value of this

variable must be the name of an existing domain group that meets all of the following

requirements:

■ It includes the user as a member.

■ It appears on the users group list.

This environment variable must be set on every ClearCase LT host. On Windows NT

systems, you set the value of CLEARCASE_PRIMARY_GROUP using the System

program in Control Panel. On Windows 98 or Windows Me systems, you must set

value of CLEARCASE_PRIMARY_GROUP in the autoexec.bat file on each system

running ClearCase LT.
14 Installation Issues



For more information on CLEARCASE_PRIMARY_GROUP and ClearCase access

controls, see Administering ClearCase.

Slashes in Installation Directory Not Supported

The ClearCase Installation Directory text box in the ClearCase Installation Wizard

does not support slashes (/).

Deinstalling ClearCase May Remove Web Interface Views

By default, views for Web interface users are created under the host data directory for

ClearCase (ccase-home-dir\var). If ClearCase is deinstalled, the view directories are

deleted, but the views remain registered. To avoid leaving entries for nonexistent

views in the ClearCase registry, do one of the following:

■ Remove any views created by Web interface users before removing ClearCase

from a Web server used to provide access to the ClearCase Web interface.

■ Use the –view_storage option in the ccweb.conf file to designate some other location

for Web interface views.

The var directory is not removed by the deinstall process. You must explicitly choose

to remove the directory.

Invalid Install Option

A network installation of Rational Suite installs both ClearCase LT Client and the

optional Rational Shipping Server feature. Because this is an invalid combination, the

Shipping Server installation is disabled after installation. Only ClearCase LT Client

can be run.

Similarly, a user can explicitly install this invalid combination, with the same result:

the Shipping Server installation is disabled and only ClearCase LT Client can be run.

Network Installation Not Supported

The Rational installation program has an option for a network installation on the

Setup Configuration  dialog box (see Rational Suite Release Notes). This option is not

recommended when installing ClearCase LT Client or ClearCase LT Server and it is

not supported. We recommend performing a typical installation of ClearCase LT

software.
ClearCase LT Release Notes 15



Dual-Boot Installation Failure

When installing ClearCase in Windows NT on a dual-boot computer (Windows NT or

Windows 98), the installation encounters an assertion failure.

At the beginning of the installation, an error message appears stating something like

this:

Assertion failed!

Program: path-name
File: file-name
Line: line-number
Expression: "Function not implemented: " ...

For information on how your program can cause an assertion failure, see

the Visual C++ documentation on asserts.

(Press Retry to debug the application – JIT must be enabled.)

The message box contains three buttons: Abort , Retry, and Ignore .

Workaround: Follow this procedure to complete the installation:

1 Abort the installation (click Abort  in the message box).

2 In the Windows NT registry, set the following registry key to 0:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows NT\CurrentVersion\

WinLogon\ParseAutoexec

3 Reinstall ClearCase LT.

Installation of UCM Integration with Rational ClearQuest

To use the UCM integration with ClearQuest, take into account the following issues

with  the compatibility and version support of the following elements:

■ ClearCase LT version (client and server)

■ ClearQuest version

■ UCM schema package

■ ClearQuest metaschema feature level

Consider the following points:

■ The feature level of the metaschema for ClearQuest 2001.03.00 database is 3. The

feature level for ClearQuest 2001A.04.00 database is 5.

■ A ClearCase LT Version 2001A.04.00 client requires a ClearQuest 2001A.04.00

client, because the integration of UCM with ClearQuest uses new ClearQuest API

calls.
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Table 6 shows the compatibility of different releases of ClearCase LT and ClearQuest,

UCM Package Revision Number, and the ClearQuest database feature level.

To upgrade to Version 2001A.04.00 from 4.1 and continue to use your integration of

UCM with ClearQuest, you must perform the first two steps. The last two steps are

optional.

1 Install ClearQuest.

2 Install the ClearCase LT client (or both ClearQuest and ClearCase LT

simultaneusly).

3 Upgrade your UCM-enabled ClearQuest schema with the new version of the

UnifiedChangeManagement package.

4 Upgrade your ClearQuest user database to the new version of the schema.

ClearCase Clients Need Compatible Language Settings

All ClearCase client computers that access a common set of VOBs and views must use

a single common character encoding system. If all computers are not configured this

way, ClearCase operations may fail or produce confusing or unreadable output.

For example, the Japanese SJIS and Japanese EUC encoding systems are available.

They both represent Japanese characters but are incompatible. For this reason, you

cannot mix SJIS and EUC in ClearCase clients.

Table 6 Integration of UCM with Rational ClearQuest

ClearCase LT
release

UCM package
revision number

ClearQuest database
feature level

UCM/CQ integration
supported?

4.1 2.0 3 Yes

4.1 2.0 5 No

4.1 3.0 3 No

4.1 3.0 5 No

2001A.04.00 2.0 3 Yes

2001A.04.00 2.0 5 Yes

2001A.04.00 3.0 3 Yes

2001A.04.00 3.0 5 Yes
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Intermittent Problem with ALBD Server During Installation

The ClearCase LT installation may occasionally display the following error message:

Error 1069: ClearCase ALBD could not log in due to wrong password.

(Note that you may have to check the Event Viewer in order to see this error.)

If you see this error message, follow the steps below to correct the problem:

1 Start Control Panel >Services . (On Windows 2000, click Control
Panel >Administrative Tools >Services).

2 Select Atria Location Broker .

3 Click Startup . (On Windows 2000, click Action >Start ).

4 Type a new password in the Password box, and confirm it in the Confirm Password
box.

5 Click OK.

6 Click Start .

Product Documentation

The ClearCase LT documentation available with this release comes in print and online

formats. The books included with each license are Installing Rational ClearCase LT,
Administering Licenses for Rational Software, and Introducing Rational ClearCase LT.

Note: The only manuals updated for this release are the ClearCase LT Release Notes
(this document), Installing Rational ClearCase LT, and the ClearCase Product Family
Documentation Supplement.

Other books can be purchased separately from the Rational Press Shop at

www.rational.com/shop, including Introducing Rational ClearCase LT, Administering
ClearCase LT, Managing Software Projects with ClearCase, and the ClearCase Reference
Manual.

All ClearCase LT documentation is provided on line, including this document,

ClearCase LT Release Notes (cc_relnotes.pdf). For more information about online

documentation, click the Contents  tab in ClearCase Help and refer to the Online
Manuals  entry.
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Restrictions and Guidelines for ClearCase LT

This section presents restrictions, limitations on, or guidelines for the use of

ClearCase LT software that are considered noteworthy. These are not considered

defects because the behavior reported is not expected to change in a future release of

the product.

Guidelines for Using UCM

This section describes guidelines for and restrictions on using Unified Change

Management (UCM) in ClearCase LT.

When Setting Up a Project, Make Components Read-Only Initially

You cannot change an integration stream’s configuration to use an earlier baseline of

any components that are marked as modifiable by the stream’s project.

This may be a problem when creating a new project if the precise set of foundation

baselines is not known in advance. After a modifiable baseline has been added to a

project, it is not possible to roll back to an earlier baseline later on if building or testing

indicates this is necessary.

To work around this limitation, initially specify your components to be nonmodifiable

when creating a new project. After verifying that the project builds and tests correctly,

update the project policies to allow modifications to any/all components.

Checkin to Non-UCM VOB from UCM View if ClearQuest Enabled

If, in a UCM view, you check out or check in an element that is not a UCM component,

you should not have to select an activity, because that operation is not captured in a

change set.

However, in a view that is in a ClearQuest-enabled project, both the Check Out dialog

box and the Check In  dialog box force you to select an activity even though one is not

really required.

Workaround: Select the activity; it will be ignored.

Notes on Using the UCM-ClearQuest Integration

The UCM process in a ClearCase LT system is enhanced for users who have installed

the Rational ClearQuest product by a very tight integration between UCM activities

and the change request management provided by ClearQuest software. Use the

following guidelines with the UCM/ClearQuest integration.
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Transitioning a ClearQuest-Enabled Project After Delivery

If the Do ClearQuest action after delivery  policy is enabled on a UCM project, delivery

of a ClearQuest-enabled UCM activity may result in an attempt to transition the

activity to a Complete state type.

If the activity record has a field that must be filled in before it can transition to the

Complete state, the program displays an error. An example is the Defect record type in

the default UnifiedChangeManagement schema, whose Resolution field must be

non-empty before it can be resolved.

Workaround: Modify the UCU_CQActAfterDeliver global script to include code similar

to that below. This automatically fills in the Resolution  field when the activity is

delivered.

REM Add complete resolution code

REM Defect record type requires Resolution field to be non-empty

’Get hook’s session context

Set Session = GetSession()

’Get the entity

Set entity = Session.GetEntity(entity_type,entity_id)

REM If record type is "Defect" ...

If(entity.GetEntityDefName = "Defect") Then

REM If Resolution field is empty...

If(entity.GetFieldValue("Resolution").GetValue = "") Then

REM Fill in required field

session.EditEntity entity, "modify"

Call entity.SetFieldValue("Resolution", "Fixed")

msg = entity.Validate

REM Remember to do some action if validate fails

entity.Commit

End If

End If

See the ClearQuest API documentation for information on editing entities.
20 Guidelines for Using UCM



Schema Requires Submitted State

If you are applying the UCM package to a custom ClearQuest schema (as opposed to

using the out-of-the-box Unified Change Management schema), be aware that this

package depends on the existence of a state with the name Submitted . If your custom

schema does not include a state with this name, you can apply the package to your

schema by using one of the following methods:

■ Before applying the package, temporarily rename the state that is the target of the

Submit  action to Submitted . Apply the UCM package and rename the state to its

original name.

■ Create a dummy state called Submitted , and assign its state type to Complete . If

you do this, you must also create a dummy action whose target is the Submitted
state. After applying the UCM package, you can delete the dummy state and

action.

ClearQuest Script Error Text not Reported

Using the UCM-ClearQuest integration, you can customize the Check Before Deliver
ClearQuest Visual Basic policy script. However, if the script as customized contains

an error that causes the Visual Basic interpreter to display an error exception, the

Deliver dialog box reports this error like this:

An error occurred during the deliver.

Unexpected error in deliver.

It does not report the actual error exception text which would enable the user to

diagnose the problem script.

Workaround: To see the error exception text, use the cleartool deliver command.

Must Kill ClearQuest Server to See Schema Upgrade

Using the UCM/ClearQuest integration, if you upgrade a ClearQuest user database

to a new schema revision, in order to see the change on a client machine which was

connected to that user database, you must do the following on the client machine:

On Windows NT or Windows 2000

1 Start the Task Manager and go to the Processes  tab page

2 From the list, select CQINTS~2.EXE or CQINTSVR11.EXE.

3 Click End Process .

On Windows 98 and Windows Me

1 Press CTRL+ALT+DELETE.
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2 From the list, select CQINTSVR11.

3 Click End Task .

Changes to UCM CustomQuery1 Do Not Appear in Dialog Box

When using the UCM-ClearQuest integration, the list of records displayed in the list

on the Add To Source , Check Out and Check In  dialog boxes is generated by running

the UCMCustomQuery1 query, which can be customized. (Note that in order to see the

effect of your changes, you must use the File >Save menu item to save the query

edits.)

However, if you copied the Public Queries UCMCustomQuery1  query into your

Personal Queries folder and edited it there, the changes are not immediately seen. To

see your changes, you must stop the integration server process:

On Windows NT or Windows 2000

1 Start the Task Manager and go to the Processes  tab page

2 From the list, select CQINTS~2.EXE or CQINTSVR11.EXE

3 Click End Process .

On Windows 98 and Windows Me

1 Press CTRL+ALT+DELETE

2 From the list, select CQINTSVR11

3 Click End Task .

After stopping the process on your computer, open the dialog box again. Further edits

to /PersonalQueries/UCMCustomQuery1 show up without your having to shut down

the process again.

ClearCase LT Client Loops on Windows 98 Systems with ClearQuest

If ClearQuest software is incorrectly configured (for example, connected to the wrong

database), ClearCase operations such as checking an element out will fail, because the

ClearQuest record corresponding to the UCM activity cannot be located. On

Windows 98 systems, this failure can cause the dialog box to be “stuck” so that

clicking Cancel  does not remove it. To work around the failure, do one of the

following:

■ Click another window before clicking Cancel .

■ Press CTRL+ALT+DEL to start the Task Manager; in the Task Manager, kill the

program that is displaying the dialog box.
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Cannot Import UCM-Enabled Records from a ClearQuest Database

In general, you cannot import UCM-enabled records from a ClearQuest database;

ClearCase LT software cannot guarantee that UCM information referencing an

arbitrary ClearQuest database is correct. However, this restriction does not prevent

data recovery in the event of a data loss. You may successfully import records into a

ClearQuest database if all the following conditions are true:

■ The records have been backed up from that database.

■ The name of the database has not changed.

■ The ClearCase LT UCM information in the record is still valid.

Cannot Delete a Project Record in ClearQuest

If you are working with a UCM project that is linked to a ClearQuest user database

and attempt to delete the project record, you get a run-time error. You cannot delete

the record or undo the CommitAction hook. The workaround is to use the squid_patch
utility to force the ucm_vob_object  field of the orphaned project to 0.

Changing Name of ClearQuest Record Type Causes Error

In the UCM-ClearQuest integration, if you change the name of the ClearQuest record

type after activities have been linked to ClearQuest records of that record type, the

integration displays an error message when you try to set one of those activities in a

view. To change the name of a record type, do so before any activities are linked to

records of that record type.

Opening Multiple Nested ClearQuest Forms May Cause Crash

The ClearQuest integration for UCM does not prevent you from opening a

ClearQuest form, then going to the form’s UnifiedChangeManagement page, then

using the context menu in the change set to open a ClearCase  dialog box, and then

selecting Activity Properties , which opens a second ClearQuest form.

However, if you follow the above steps, the second ClearQuest form does not function

correctly. In particular:

■ The Apply , Revert , and Cancel  buttons on the form have no text.

■ If you attempt to go to the form’s UnifiedChangeManagement page, then dismiss

the form, you get the error:

Unable to load message ID 14090 from resources

ClearCase then crashes.
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Therefore, we recommend that you not use the above procedure to open a second

ClearQuest form.

Notes on Using the Base ClearCase-ClearQuest Integration

This section provides guidelines for using base ClearCase (non-UCM) and ClearQuest

together.

Using ClearQuest with Long Version-Extended Pathnames

The base ClearCase-ClearQuest integration creates a ClearCase  tab on your

ClearQuest screen. On this tab, if you right-click CC Change Set Objects  and then

select View Details , the program displays data about a VOB element. If the

version-extended pathname is too long to fit in the dialog box, it cannot be viewed in

its entirety, because the form does not support horizontal scrolling by default. You

may want to modify the form using the following procedure:

1 In ClearQuest Designer, check out the ClearQuest schema you are using.

2 Click Record Types-Stateless > cc_vob_object >Forms >cc_vob_object .

3 Select each text box and double its height.

4 Right-click a text box and click Properties .

5 Select the Extended  tab.

6 Select the Horizontal Scroll Bar check box.

7 Repeat Step #4 through Step #6 with the other text box fields.

8 Check in the schema.

9 Click Database >Upgrade Database  to finish the changes.

If you wanted only the horizontal scrollbase on the name, do the following instead:

■ In Step #3, select the name text box and double its height.

■ In Step #4, right-click the name box and click Properties .

■ Ignore Step #7 which asks you to repeat the instructions.

Restrictions on ClearCase LT Web Interface

The following restrictions apply to using the ClearCase LT Web Interface.
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Restrictions on the Web Interface in a UCM Environment

If you are using the Web interface in a UCM environment, the following restrictions

apply:

■ You can work only on existing activities that you own; you cannot create new

UCM activities using the Web interface.

■ You cannot deliver changes to an integration view.

■ You cannot rebase your development stream.

■ You cannot use the Web interface to view ClearQuest-enabled projects.

Interactive Triggers Fail When Accessed Through Web Interface

The ClearCase Web interface supports noninteractive triggers. Interactive triggers,

such as those that attempt to read input or create a window, will fail.

If a trigger attempts to read input using clearprompt, the ClearCase Web interface

displays this error:

clearprompt is not supported in the Web interface

If a trigger attempts to read directly from standard input, it fails because standard

input does not specify a valid file descriptor.

In addition, any trigger failure in the Web interface context displays this error

message:

Interactive triggers are not supported in the Web interface.

If the trigger was interactive, it may have failed for that reason.

Trigger script writers can detect whether a trigger is running in the Web interface

context by checking for the environment variable ATRIA_WEB_GUI. It is set to 1 if you

are running in the Web interface context.

Changes to Files Not Checked Out May Be Silently Overwritten

If you use the Web interface to download (rather than check out) a file to your Web

view and then modify the file, your changes to the file are silently overwritten if you

download the file again from within the same view. The program assumes that only

changes made to checked-out files are meant to be saved.
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Restrictions on Comparison of New Element Types

The Web interface does not support graphical (tree view) comparison of XML file

elements; the Web Compare tool displays a text-based comparison for elements of

type .xml . When comparing HTML files, the program displays the differences in the

Compare screen as text, but includes hyperlinks to display the individual files

appropriately formatted using your default browser.

In addition, because the Compare tool in the Web interface handles only text files, it

does not support comparison of Rational Rose or Microsoft Word files.

Error When Checking in Large File from Windows NT Web Client

Windows NT 4.0 sends very large amounts of information to a Web server. This

behavior causes the ClearCase Web interface to fail when attempting to check in very

large files (on the order of several megabytes). This problem appears to be fixed in

Windows 2000.

Host Name Resolution Must Be Enabled on Web Interface Clients

The Java program used in the Web interface attempts to connect to the Web server to

transfer files. Web browsers only allow Java programs to open connections to the

server from which the programs were downloaded.

To enforce this rule, the Web browser on the Web interface client must be able to

resolve the Web server’s host name to an IP address. If you use a host name in a URL

that cannot be resolved by the client host, the Java program cannot connect to the

server. In this case, Web-interface file-transfer operations such as checkout, checkin,

and download fail.

If the Web server is being accessed through a firewall by a proxy server, the proxy

server being used must support DNS lookup outside the firewall.

ClearCase Web Interface Problem in Overriding Primary Group

When the ClearCase Web server running on Windows logs in a client, it sets the

primary group to the designated primary group in the client user’s domain account.

As a result, sites that use domain mapping to allow user accounts in multiple domains

to share VOBs cannot access those VOBs through the ClearCase Web Interface.

Workaround: Specify a configuration variable in the ccweb.conf file, and add a value to

the registry that overrides the group setting and enables domain mapping.
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Adding the Variable to the ccweb.conf file

To enable a single Web server to support one primary group override, add the

–primary_group variable with a groupname value to the ccweb.conf file. The allowable

values for groupname are the same as for the CLEARCASE_PRIMARY_GROUP
environment variable. The ccweb.conf file must be located in .ccase-home-dir\var\config.
If you need more than one primary group override, configure additional Web servers.

Setting the Registry

Typically, when domain mapping is used to allow users from multiple domains to

access the same VOB, each user must create the DomainMappingEnabled  value (set to

1) in the HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion registry key.

To enable domain mapping for a Web server, create the DomainMappingEnabled value

in the HKEY_LOCAL_MACHINES\Software\Atria\ClearCase\CurrentVersion key on the Web

server machine. The value must be of type DWORD and set to 1.

If you log in directly to the machine instead of logging in through the Web interface,

user values for DomainMappingEnabled  override the machine value.

Conflict Between Netscape and Earlier Versions of Exceed X
Server Windows

If you access the ClearCase Web interface using a Netscape browser on a Windows

system and also use a version of the Exceed X Windows Server earlier than 6.0, do not

let the Netscape window lose its focus to an Exceed window. Doing so causes the

Netscape window to restart any Java applets it is currently running, which interferes

with file transfer operations, for example, download, checkout, or checkin.

Neither Internet Explorer nor Version 6.0 of the Exceed X Server has this problem.

Using Internet Information Server to Serve Web Pages from a VOB

If you intend to use Internet Information Server (IIS) to serve Web pages within a

view and VOB, you must configure IIS to log on as a Windows NT domain user that

has access to that view and VOB data. Use this procedure:

1 Make sure that the views and VOBs serving the Web pages use NTFS, not FAT, for

storage.

2 Start the Services Control Panel program.

3 Double-click World Wide Web Publishing Service ; a Service  dialog box appears.

4 Click Manual startup type, and then click OK.
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5 Create a domain user who is a member of the same primary group as ClearCase

users.

6 Make the user the Anonymous Login  user for IIS:

a Click the Windows Start button, then click Programs >Microsoft Peer Web
Services >Internet Service Manager .

b Start the WWW service, if necessary.

c Double-click Service  to display its property sheet.

d Enter the username in the format domain\user , for example, atria\webclient.

7 Start the view or views from which you want to publish and mount the VOBs you

need.

8 Start the IIS service.

9 On the Directories  tab, set aliases to directories in the VOB or VOBs.

IIS and ClearCase should now work together on the same computer.

Note: Make sure that whenever you restart your computer, you always start views

and mount VOBs before you start the IIS service.

Third-Party Integration Guidelines for Version 2001A.04.00

ClearCase LT contains support for Visual Studio 97 and Visual Studio 6.0 (including

Visual InterDev), tools that use the Microsoft Common Source Code Control Interface

(SCC) integration. It also contains support for Microsoft Word, Microsoft FrontPage,

Microsoft Office 2000, and Sybase PowerBuilder. This section contains guidelines on

using ClearCase with integrated products.

Using ClearCase LT with Microsoft Web Tools

ClearCase LT is integrated to work with FrontPage 98, FrontPage 2000, Visual

InterDev, Microsoft’s Save to Web Office 2000 functionality (Word, Excel,

PowerPoint), and Microsoft Internet Explorer 5 (IE5) Web Folders.

When using ClearCase LT with these programs and tools, follow the guidelines

below:

■ Users/Groups that are granted Front Page Server Extensions (FPSE) Author  rights

must match the identities of the Users/Groups with write access to the Web

content VOB. In particular, granting Author  rights to Everyone  or to the IIS

Anonymous  user is not supported.
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■ The ClearCase/FrontPage Web server maintains a cache of source control

information, including checkout status, user, time, and version. This cache is not

updated when source control operations are performed using ClearCase tools such

as the Version Tree Browser, or cleartool, rather than from within a Microsoft Web

program like FrontPage. For this reason, it is recommended that all source control

operations be performed from within the appropriate Microsoft Web tool. In the

integration with FrontPage 2000, the ClearCase commands Update View  and

Refresh Source Control Status  and the iisfix.bat script can be used to resynchronize

the cached source control information.

■ Use of FrontPage borders and themes can cause many extra source control

operations to be performed, slowing integration performance.

■ As described in the online help for the integration, users access files using a shared

snapshot view created for the ClearCase/Web tools integration on the ClearCase

Web server; the view tag of this view is fp_hostname_default-web-alias-path. If a Web

uses the IIS Challenge/Response authentication method, this view must be located

on the IIS Web server, and the VOB must either be on the same IIS Web server or

on a UNIX VOB server configured to use CCFS.

■ If you are attempting to import an existing Web with FrontPage Server Extensions

installed into a VOB, you must remove all vti* directories from the Web before

using clearexport_ffile/clearimport.

Using ClearCase LT with Visual InterDev

The integration between ClearCase LT and Visual InterDev may cause corruption and

data loss. The problem occurs when user A checks out a file and then user B checks

out the same file; user B is permitted to check in before user A. When user A attempts

to check in the file, user A receives an error message and the file is corrupted.

There are three ways to deal with multiple-checkout problems in Visual InterDev:

1 Add all users who may potentially check out the same files at the same time to the

ClearCase domain group. This gives users permission to check in files checked out

by another user.

2 Enable simulated checkouts for all files in the Web content VOB. This will mean

that an actual check out does not occur at check out time; rather, it is deferred until

check in time. This allows multiple users to successfully check out the same file at

the same time. However, these checkouts will only appear in the Visual InterDev

GUI and not in ClearCase applets. To enable simulated checkouts, change the

value of the registry key:
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Change the registry key

HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\Performance\
SystemFiles from the default value to the string value *.

3 Disable the multiple-checkout functionality. To disable the multiple checkout

functionality, you must turn on a new registry key. Once this new registry key is

set, the multiple checkout support is disabled, and Visual InterDev enforces a

single checkout model. To disable multiple checkout functionality, add the new

registry key as a DWORD value:

HKEY_LOCAL_MACHINE\Software\Atria\ClearCase\CurrentVersion\SSAPI\
FailCOIfAlreadyCO

If the value is set to 1, a checkout fails if the object is already checked out.

Using ClearCase LT with Microsoft Visual Studio

To use the ClearCase integration with Visual Studio, users must do one of the

following:

■ Install ClearCase after installing Visual Studio.

■ When installing Visual Studio, choose the option to do a custom install. Then

choose to not do either of the following:

❑ Install Visual Source Safe

❑ Make Visual Source Safe the source code control program

Using ClearCase LT with Microsoft Visual C++

ClearCase uses the Microsoft Common Source Code Control (SCC) interface to

integrate with the Microsoft Visual C++ available through Microsoft Visual Studio.

ClearCase has support for Visual C++ versions 5.0 and 6.0. However, you cannot

enable the ClearCase SCC support for both versions at the same time. You can switch

between SCC-support versions 5.0 and 6.0, but only one version is enabled at a time.

By default, the ClearCase SCC interface support for Visual C++ 6.0 is enabled, unless

you have previously installed ClearCase support for Visual C++ 5.0. The ClearCase

SCC interface for Visual C++ 6.0 also supports Visual Basic 6.0, Visual J++ 1.1, and

Visual InterDev 6.0.

Using ClearCase with Visual Studio components requires no special configuration on

the part of the user. For more information, see Developing Software with ClearCase.
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Issues with Visual C++ on Windows 2000

If you install Windows 2000 on a machine that currently runs Windows NT with the

ClearCase integration for Visual Studio, and you reinstall ClearCase LT, the Visual

C++ 6.0 Addin toolbar for the ClearCase integration contains five Version Tree
buttons. All five buttons start the Version Tree Browser. To correct the problem,

remove the ClearCase toolbar and then re-add it, as follows:

1 Click Tools >Customize  and click the Add-Ins  tab.

2 Clear the ClearCase  check box on the list and close the dialog box.

3 Click Tools >Customize  and click the Add-Ins  tab.

4 Select the ClearCase check box and close the dialog box.

Using ClearCase LT with Microsoft Visual Basic

Disabling the IDE During Project Debugging

The Visual Basic IDE by design disables or unloads all add-ins while debugging a

project. Therefore, the ClearCase toolbar, which is an add-in, is disabled; no ClearCase

operations can be performed from the Visual Basic IDE while the debugger is

running. ClearCase operations can be performed while debugging outside the Visual

Basic IDE by using the ClearCase Explorer.

ClearCase Tools Add-In Does Not Initialize with Visual Basic 5.0

In ClearCase LT Version 2001A.04.00, a new add-in was created for Visual Basic 5.0.

The add-in does not work with versions earlier than Visual Basic 5.0. If you use an

earlier version, the following message window appears:

ClearCase tools could not be loaded

Remove it from the list of available addins?

Because the purpose of this add-in is to provide Visual Basic users quick toolbar

access to advanced ClearCase features, you can remove it from the add-ins list

without affecting basic ClearCase functions such as checkin and checkout.

Problem Checking in Identical .frm Files in Visual Basic 6.0

By default, ClearCase does not create a new version of a file that is identical to its

immediate predecessor. When you attempt to check in a .frm file that is identical to

the checked-in version, the integration does not check it in. However, if the .frm file

has an associated .frx file, the integration checks in the .frx file as a read-only file. To

avoid this problem, set the option to allow identical checkins.
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Pre-Checkin Trigger Causes Problem in Visual Basic Projects

In Visual Basic when you attempt to add a project to ClearCase LT by clicking

Tools >ClearCase >Add Files to ClearCase , the operation fails if the VOB in which the

Visual Basic project resides has a trigger that requires users to enter a comment when

checking in files. The Visual Basic IDE does not supply the comment that you enter in

the Add to Source Control  dialog box to the trigger.

To work around this problem, use ClearCase Explorer to add the project to source

control. After you add the project to source control, checkin and checkout operations

complete successfully from within the Visual Basic IDE.

FRX File Not Checked Out When Part of Visual Basic Group

In a Visual Basic version 6.0 project that is part of a Visual Basic Group, when you

check out a .frm file (with a .frx file), ClearCase does not check out the associated .frx

file automatically. This behavior may cause synchronization problems. When working

with a Visual Basic 6.0 project that is part of a Visual Basic Group, be sure to check out

both the .frm and .frx files.

Error Message When Opening Visual Basic 6.0 Project

When you open a Visual Basic 6.0 project that is checked in, the integration displays

the following error message:

Failed to update project location information in the host application

The integration displays this message because the Visual Basic project file is not

checked out and the project location information cannot be updated. To avoid this

message, check out the project file and then open the project.

Reopening Visual Basic 6.0 Project Fails to Update Project Information

When using Visual Basic 6.0, a problem can occur if a project’s source files reside in a

dynamic view that is mapped to drive M. Visual Basic cannot reopen the project from

the list of recent projects at the bottom of the File  menu.

To work around this problem, you can delete the file, MSSCCPRJ.SCC, then add the

project back to source control.

Using ClearCase with Microsoft Word

ClearCase LT Version 2001A.04.00 includes integrations with Word 97 and Word 2000.

To use either of these integrations, do the following:
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1 Remove any existing user-defined ClearCase/Word integration packages from the

system. If this is not done, the ClearCase LT Version 2001A.04.00 Word integration

may not install properly.

2 Run the ClearCase Word Integration configuration program by clicking

Start >Programs >Rational ClearCase Administration >Integrations >Microsoft Word
Integration Configuration . Note that Word 97 or Word 2000 must be installed before

you run the configuration program for it to take effect.

Removing a User-Defined ClearCase/Word Integration

A user-defined ClearCase/Word integration is encoded in a VisualBasic script file

with the extension .dot, located in the Word startup directory. To determine the Word

startup folder, follow these steps:

1 In Word, click Tools >Options .

2 In the Options  dialog box, click the File Locations  tab.

3 On the list, double-click Startup  to open the Modify Location  dialog box.

4 Right-click the large list box in the center of the dialog box (the list box may be

empty) to display the shortcut menu; click Explore  to start Windows Explorer. In

Word 2000, the startup folder is displayed in the Folder name box in the dialog box.

The Explorer view is rooted in the Word startup folder.

To remove a previous integration, remove its associated .dot file from the Word

startup directory, or rename the file using a different extension.

Using the Tracing Mechanism

The Microsoft Word integration supports a tracing mechanism that can be used to

help diagnose certain problems. Enable it by creating the DWORD registry key.

HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion\Word\Tracing Enabled

Then set the key value to 1.

Note: To leave the key in the registry when not in use, set the value to 0.

The tracing is in the form of pop-up message boxes that open immediately before

commands like Check Out  or Check In  are issued. This can be useful in determining

the pathname of the document or the name of the command that is about to be issued.

Note that the registry key is checked when Word starts, so changing it during a Word

session has no effect unless you stop Word and restart it.
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Deleting the ClearCase Menu Bar

If the ClearCase  menu is somehow deleted and the attached template is then saved,

that document, and any document subsequently opened using that template, loses

access to the ClearCase menu. This happens because menus and toolbars are modified

in documents in Microsoft Word, not in the application.The ClearCase integration

adds the ClearCase  menu to the ClearCase Word template file.

If you delete the ClearCase menu, you can restore it by using the following procedure:

1 Open the document or affected template.

2 Click Tools >Customize , then select the Menu Bar  in the list. That is, select the line

by that name in the list control; do not simply select or clear the check box.

3 Click Reset.

4 Select the affected template file and click OK. Then close the Customize dialog box.

Add to Source Control Menu Shortcut Terminates Microsoft Word

We recommend that you not initiate an Add to Source Control  operation from the

ClearCase  menu that appears when you right-click in the SaveAs  dialog box in

Microsoft Word. This may cause your Word application to terminate abruptly and

could possibly cause data loss.

Using ClearCase LT with Sybase PowerBuilder

Using the ClearCase integration with PowerBuilder requires some configuration

steps. In addition, there are some differences between the integration with

PowerBuilder 6.x and PowerBuilder 7.x.

Applying Patches to PowerBuilder 7.x

Before using the ClearCase integration with PowerBuilder 7.0 to 7.02, apply the latest

PowerBuilder patch available for the file PBSCC70.DLL. You can download this patch

from the Sybase FTP site at

ftp://psaftp.sybase.com/pub/private/pbpatch/pb701.weekly/202861.zip. This patch is not

needed for PowerBuilder versions later than 7.02.

Enhancing the ClearCase/PowerBuilder Integration

Use the following procedure to add a Help  button to the ClearCase PowerBuilder

integration. After the integration is configured, PowerBuilder displays an icon for

ClearCase Help on its toolbar.

1 Start PowerBuilder
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2 Right-click the Powerbar (where the icons are located); click Customize .

3 Click the Custom  option.

4 Drag your icon to the Powerbar  and position it on the bar.

5 To separate the ClearCase Help  button from others on the Powerbar , use one or

more separator icons (located in the upper left corner of the group of available

icons).

6 A dialog box prompts you to enter the command line that will be associated with

the icon, as well as text to represent the icon in the microhelp and when the cursor

is positioned over the icon. Set the command line to the value winhlp32.exe
ccase-home-dir\bin\ph_int.hlp. Set the values of the Item Text and Item Microhelp boxes

to ClearCase Help.

7 Click OK to finish the configuration.

Error5 Message When Using PowerBuilder Integration

If you select an object from the public directory and click Source >Register , the

integration opens a dialog box where you enter the name of the .PBL library. If the

library you specify does not exist in the archive directory, the integration creates a

new one and adds it to source control in the archive directory. If you attempt to check

out the same object from the public directory by clicking Source >Check Out
specifying a different name, the integration fails with an “error5” message. To work

around this problem, be sure to enter the exact name of the target .PBL when you

check out an object.

ClearCase Integration Differences: Version 6.x and 7.x

The current ClearCase integration with PowerBuilder reflects the following

enhancements in PowerBuilder Version 7.x over Version 6.x:

■ The Source  menu includes the command Add Objects .

■ There is no Source >Create New Release  command; that functionality is provided

by Library >Create .

■ If your VOB is set up for UCM development, ClearCase displays an Activity option

when you open the Configuration  dialog box by clicking

Source >Configuration >Advanced

Diff Merge Issues

This section describes issues with the Diff Merge tool.
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Diff Merge Tool Does Not Display Multibyte Characters Correctly

The Diff Merge tool may not display multibyte characters correctly.

Workaround:

1 On the Tools  menu in Diff Merge, open the Options  dialog box .

2 Click Change .

3 Change the font to one that displays multibyte characters correctly on your

computer.

Number of Lines in Compared or Merged Files

Files that are compared or merged with the ClearCase Diff Merge tool on

Windows 2000 cannot contain more than approximately 3,000 lines. Some font sizes

may increase that limit to approximately 4,000.

Some Diff Merge Customizations May Be Lost

The marker for unaltered text in a Diff or Merge contributor pane has been changed. It

was previously labeled No Change  in the Options dialog box. It is now labeled

Unchanged . Because the text shown in the list box is the actual registry key under

which the font characteristics (for example, color, bolding, italic) are stored, the

registry has also changed slightly.

As a result, any lines marked Unchanged  revert to the application's default for that

type of marker. Any modifications that the user may have made (for this marker

only), revert to the default. Modifications for all other marker definitions are retained.

Useful Registry Settings for Diff Merge Tool

There are useful registry settings in

HKEY_CURRENT_USER\Software\Atria\ClearCase\CurrentVersion\Diff Merge that cannot be

set through the GUI. To change these settings, exit all Diff Merge sessions before

changing the registry. If you do not, the values entered manually are overwritten

when Diff Merge exits.

Tab size  is a numeric value that determines the number of characters a tab character

occupies. The default value for this key is 8. If you set Tab size  to 0 or less, it is

overridden with 8 and is saved on exit.
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Colorbar scaling factor sets the width of the color density bar in the Diff Merge tool as

a percentage of the width of the vertical scroll bar. For example, if this value is 100 , the

two bars are the same width. If the value is 50, the color bar is half the width of the

scroll bar. The default value for this key is 75. If you set Colorbar scaling factor  to a

negative value, a value of 0 is used. A Colorbar scaling factor  of 0 hides the colorbar.

Guidelines on Using the XML Diff Merge Tool

This section notes restrictions and special issues involved in using the XML Diff

Merge Tool.

XML Diff Merge Restrictions

Use of the XML Diff Merge tool is subject to the following restrictions as a result of its

use of Version 1.0 of the XML expat parser:

■ All entity declarations for entity references must be within the document; in other

words, the constructs specified by the standalone="no" document declaration are

not supported. For more information, see the Standalone Document Declaration and

Entityref sections (especially the Well-Formedness Constraint: Entity Declared
subsection) in the the XML 1.0 Recommendation.

■ If an entity (other than the predefined entities) is not declared, a parser error

message appears on input. In this case, input processing of the document stops,

but the application proceeds.

■ External files entities defined using the SYSTEM declaration are read to find

externally defined entities, but XML document content defined in these files is not

interpolated into the document.

■ There is no validation of XML documents, because the parser we use is not a

validating parser. On the other hand, the tool tests for well-formedness; it issues an

error message and exits upon traversal of a document that is not well-formed.

■ Because the parser only parses the internal DTD subset, rather than parsing an

external DTD associated with an XML file, it does not handle documents that

depend on the resolution of parameter entity references.

■ There is no support for Unicode (UTF-16); the parser converts all the input

encoding (for example, ISO-8859-1) to UTF-8 output.

In addition, the following restrictions also apply:

■ There is no support for editing element attributes or PCDATA; users must make a

choice between contributors to resolve conflicts, rather than modifying the result.
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■ There is no support for attribute-granularity merges. Users must choose an

element with all its associated attributes from a single contributor. They cannot

select some attributes from one contributor and other attributes from another.

■ The choices you make in merging different versions of an XML document are

inherited hierarchically. That is, when you select an element to be included in a

merged file, all children of that element are selected as well. You cannot select an

element from one contributor and replace a child of that element with the content

of that child in a different contributor.

■ Users cannot change or undo any choices made during the course of a merge; that

is, you cannot alter an insertion, change, or deletion after you have selected it.

■ Color customizations for the XML Diff Merge tool are controlled by the settings for

the ClearCase text mode Diff Merge. You cannot customize the colors directly from

the XML Diff Merge GUI; you can, however affect colors in this GUI by modifying

the colors used for text mode Diff Merge.

■ The tool does not support the merge –query and merge –qall options. See the merge
reference page for a description of these options.

■ In the output file generated by the tool, nonterminal white space formatting is lost.

However, PCDATA white space is preserved.

■ The tool does not yet support the empty element tag syntax for output. Files that

contain <tag/>  constructs are parsed correctly, but the output is of the equivalent

form <tag></tag> .

Ordering of Files in GUI May Need Adjustment

If two or more contributors insert elements and these insertions are adjacent, the

desired ordering in the merge output can be ambiguous. For example, it may not be

possible for the tool to determine whether an insertion from contributor A should

appear before a corresponding insertion from contributor B.

If the element ordering is ambiguous at a given merge point, the one chosen by the

tool may not be the one desired. Review all changes in the merge output to confirm

desired ordering.

Checking Your Results

In some cases, the XML Diff Merge tool cannot evaluate a changed element correctly,

and instead reports changes to a single element as the deletion of one element and the

addition of an identically named element. Because of this limitation, we strongly
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recommend that you verify comparisons and merges done using the XML tool with

the text version of the Diff Merge tool. A button in the XML Diff Merge toolbar

enables you to quickly perform a textual Diff Merge.

XML Diff Merge Functionality Note

When merging two XML files, when you select one of two alternative elements from

the contributor panes, you effectively delete the unselected element. As a result, all

children of the deleted element are deleted as well, and cannot be selected on

succeeding merges.

Creating Elements of Type xml and Creating New Versions of XML
Elements

The xml element type is based on the text_file_delta type manager. It expects xml

elements to be text files. A text file is assumed to have lines no longer than 8,000

characters each, and no character may be a binary \000 (null) character.

ClearCase reports an error while creating an xml element or while checking in a new

version of an existing element if the xml data does not look like a text file. If your xml

data has more than 8,000 characters between line-terminating characters, its lines are

too long for the text_file_delta type manager. If your xml data is encoded with

multibyte characters it appears to have binary \000 characters when viewed as a

stream of bytes.

To overcome these restrictions, use the file element type to store such xml data. The

file element type can store any type of file and does not have the same restrictions as

the xml element type. To compare and merge xml data that is stored as file element

types, you need to invoke the XML Diff Merge tool directly. See Invoking XML Diff
Merge Directly.

If you cannot create a new version of an element of type xml, perform the following

steps:

1 Cancel the checkout and save your checked-out data in a .keep file. For example:

cleartool unco –keep file.xml

2 Change the element type from xml to file by using the cleartool chtype command.

3 Check out the file.

4 Copy the .keep file to the checked-out file.

5 Check in the file.
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Invoking XML Diff Merge Directly

To run XML Diff Merge directly:

1 Make sure the ccase-home-dir\bin directory is in your path..

2 Issue the xmldiffmrg command. For example:

To compare two versions:

xmldiffmrg –xcompare file1.xml file2.xml

To merge two or more versions using a common ancestor:

xmldiffmrg –xmerge –out file.xml.merge –base file.xml file1.xml file2.xml

The file names may be version-extended pathnames. You must use the –xcompare
and –xmerge options instead of –compare and –merge, respectively.

Guidelines on Using the Administration Console

Use the following guidelines when using the Administration Console.

Console Access to the Customer Web Site

To access the ClearCase LT Customer Web site from the Administration Console, you

must first set up your Microsoft Internet Options. You can do this either when you

first install and configure Microsoft Internet Explorer or manually using Control
Panel >Internet Options . If these options (for example, firewall and proxy server

settings) are not set up, the following message is displayed when you try to connect to

the ClearCase LT Web site:

Internet Explorer cannot open the Internet site

http://clearcase.rational.com. A connection with the server could

not be established.

Refresh Toolbar Button May Vanish Resizing a View Private File’s
Column Headers

When you display a view private file in the ClearCase Administrator or Host Console,

resizing its column headers or displaying the context menu causes the Refresh toolbar

button to be hidden. If this happens, you can access the Refresh function by using the

Action  menu pull-down, or from the shortcut menu of the view private file’s display.

Problems When Administrative VOBs Are Unavailable

The administrative VOB is used by one or more other VOBs as a central repository of

global type objects. See the type_object reference page for a description of this

feature.
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ClearCase LT users may see errors when the administrative VOB is unavailable.

Following are examples of situations when this may happen:

■ A user attempts to attach a version label, using a label type that was previously

created automatically, as a local copy of a global label type. The ClearCase mklabel
command tries to contact the administrative VOB containing the global label type.

If that administrative VOB is unavailable, the mklabel command fails.

■ A VOB backup script attempts to lock the entire VOB object of /vobs/proj\proj before

copying data to tape. For each administrative VOB used by /vobs/proj\proj, the

ClearCase lock command tries to contact the administrative VOB. If any

administrative VOB is unavailable, the lock command fails, which causes the

backup script to fail.

To disable the above checking for a particular ClearCase command (for example, to

keep working while an administrative VOB is offline):

1 Log on as administrator.

2 Set the environment variable CG_PROCFLAGS to the value no_process.

a Open the System Control Panel.

b Click the Environment tab.

c Set the user variable CG_PROCFLAGS to the value no_process.

3 Execute the command.

History Browser Produces Extremely Small Text on Japanese System

The font used for text and captions in the History Browser is 6 point type by default.

This point size produces difficult-to-read output in the History Browser on a Japanese

language system.

Workaround: To enlarge the font, click View >Options >Display >Fonts  and select a

larger font.

Keep checked out Option Changed in Add To Source Control Dialog Box

The behavior of the Keep checked out  check box in the Add To Source Control  dialog

box has changed. If you selected this check box in previous releases, the view-private

file that you added to source control remained checked out. This behavior is

consistent with the cleartool mkelem command. As a result, you could lose the

contents of this file before it was truly part of the VOB. This was most likely to happen

if you canceled the checkout.

Now, the file is checked in and checked out. You can continue working on the file, but

its contents at element creation time are preserved, even if you cancel the checkout.
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Do Not Change VOB/View Storage Directory ACLs on NTFS File Systems

On NTFS partitions, each ClearCase VOB or view storage directory has an access

control list (ACL). Modifying the ACL in any way can render the VOB or view

unusable.

Because the standard Windows NT file-copying tools (and some backup utilities) do

not preserve file and directory ACLs, use the procedures in Administering ClearCase to

copy, move, or restore a VOB or view storage directory.

Misleading Licensing Error Message

If you do not assign a ClearCase LT server for your client and you try to run any

ClearCase LT tool that contacts the server, the error message you get is the same as if

you had no license. If you get an error that tells you that you do not have a license for

the product, but you are certain that you have a valid license, make sure you have a

server name entered for the client. Click Start >Settings >Control Panel  and click the

ClearCase icon. Verify that a valid ClearCase LT server host name is in the edit field.

Restart After Changing ClearCase LT Registry Server

Some ClearCase LT operations may not work correctly after you change your default

registry server. Some symptoms include ClearCase LT shortcut menus that do not

appear correctly or source control operations that fail in Microsoft Visual Studio. We

recommend that you shut down and restart your computer after changing the registry

server.

Defects/Change Requests

Noteworthy problems found in ClearCase LT software are listed in the file

cc-issues.htm. You can find this file in the folder ccase-home-dir\install after you install

the product.

Note that any problems relating to installation or setup of ClearCase LT software are

noted in Installation Issues.

Documentation Issues

This section presents late changes to documentation and describes errors or

information missing from the documentation delivered with ClearCase LT software.
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Problems with Reference Pages

The following problems, relevant to ClearCase LT, exist in the ClearCase Reference
Manual for ClearCase Release 4.2.

Object-Creation Commands

The reference pages for object-creation commands (chpool, cptype, mkattype, mkbrtype,

mkeltype, mkhltype, mklbtype, mkpool, and mktrtype) do not mention explicitly that

the name specified for an object must not be a valid integer or real number. Be careful

with object names that begin with 0x, 0X, or 0, the standard prefixes for hexadecimal

and octal integers.

clearexport_ffile

-l is an undocumented option for the clearexport_ffile command, which labels the

imported version with the specified label. Existing instances of the specified label are

replaced.

clearexport_ssafe

The documentation for clearexport_ssafe does not mention that labels on directories in

SourceSafe are not exported.

Problems with Online Help

The following issues exist with online help:

Topic Not Found

If you start help by pressing F1 n an application window (context-sensitive help) and

begin a series of jumps into the online documentation, you may see the error help

topic not found , when in fact the topic exists. If you click OK in the error message

box, the topic then appears.

Help Window is Blank

Occasionally, a ClearCase help topic fails to appear: the title appears, but the body of

the window is blank. When this happens, you can correct the problem as follows:

1 In the Help window menu bar, click Options >Font >Normal . The Help window is

refreshed.

2 If the wrong help topic is displayed when the help window is refreshed, click the

Back  button to get back the original topic.
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Issues with Tutorials

This section describes problems with running tutorials.

Tutorials in Windows Environment

Before users run the tutorials, the administrator must set the correct view and VOB

storage needed to run the Windows NT tutorials. Users can verify that this was done

by entering the following cleartool lsstorage commands and checking the output:

cleartool lsstorage –view

cleartool lsstorage –vob

If each command does not display a list of views or VOB storage locations, the tutorial

will not run.

Start Menu Differences

In the ClearCase LT printed and online documentation, the names of programs differ

from the names that you see on the Start menu. For example, the ClearCase LT Doctor

help file says:

To start ClearCase Doctor, click Start >Programs>Rational ClearCase LT >ClearCase
Doctor . Note: if ClearCase LT was installed as part of a Rational Suite, the Rational
ClearCase LT  entry appears below the name of the suite.

The text should show the proper name of the program as Rational ClearCase LT
Doctor .

Contacting Rational Technical Support

If you have any problems with the software or documentation, please contact Rational

Technical Support by telephone, fax, or electronic mail as described below.

For information regarding support hours, languages spoken, or other support

information, click the Technical Support  link on the Rational Web site at

www.rational.com.
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Your Location Telephone Facsimile Electronic Mail

North America 800-433-5444
toll free or
408-863-4000
Cupertino, CA

408-863-4194
Cupertino, CA
781-676-2460
Lexington, MA

support@rational.com

Europe, Middle
East, and Africa

+31-(0)20-4546-200
Netherlands

+31-(0)20-4546-201
Netherlands

support@europe.rational.com

Asia Pacific 61-2-9419-0111
Australia

61-2-9419-0123
Australia

support@apac.rational.com
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